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iIbm.com and related resources

Product support and documentation are available from ibm.com®.

Support and assistance
Product support is available on the web. Click Support from the product website at:
IBM® Dagja® ViewONE®

http://www.ibm.com/support/entry/portal/product/enterprise content
management/daeja viewone

PDF publication

Y ou can view the PDF files online by using the Adobe Acrobat Reader for your
operating system. If you do not have the Acrobat Reader installed, you can
download it from the Adobe website a http://www.adobe.com.

See the following PDF publication website:

Product Website
IBM DaglaViewONE Standard http://www.ibm.com/support/docview.wss?u
id=swg27041437

IBM DaglaViewONE Professiona

IBM DagjaViewONE Virtua

How to send your comments

Y our feedback helps IBM to provide quaity information. Please share any
comments that you have about thisinformation or other documentation that IBM
Software Development ships with its products.

Y ou can use any of the following methods to provide comments:

e Send your comments by using the online readers comment form at
http://www.ibm.com/software/datalrcf/.

e Send your comments by email to comments@us.ibm.com. Include the name of
the product, the version number of the product, and the name and publication
number of theinformation (if applicable). If you are commenting on specific
text, please include the location of thetext (for example, atitle, atable number,
or apage number).



http://www.ibm.com/support/entry/portal/product/enterprise_content_management/daeja_viewone
http://www.ibm.com/support/entry/portal/product/enterprise_content_management/daeja_viewone
http://www.adobe.com/
http://www.ibm.com/support/docview.wss?uid=swg27041437
http://www.ibm.com/support/docview.wss?uid=swg27041437
http://www.ibm.com/software/data/rcf/

Contacting IBM
To contact IBM customer service in the United States or Canada, call 1-800-1BM -
SERV (1-800-426-7378).

To learn about available service options, call one of the following numbers:.<ul>
e IntheUnited States: 1-888-426-4343
e InCanada: 1-800-465-9600

For more information about how to contact IBM, see the Contact IBM website at
http://www.ibm.com/contact/ug/.



http://www.ibm.com/contact/us/

Introduction

IBM Daeja ViewONE is a Java viewer that extends your web browser so that you
can view, zoom, magnify, scroll, pan, rotate, and print your images and image
documents quickly and easily.

This document is the user manual for the IBM Daeja ViewONE Java Applet.

For further information about IBM Daeja ViewONE, consult the documentation
available to download from here:

http://www.ibm.com/support/docview.wss?uid=swg27041437



http://www.ibm.com/support/docview.wss?uid=swg27041437

The User interface
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Toolbars

Top Toolbar
File buttons

The file buttons are;

Open, Close, Save.

I222|le caa e PDE RRR DR B @ &

@ Open

Displays an open file dialog box from which you can select an image or
document file. If you click this button while holding down the shift-key or by
using the middle or right mouse button, then an open URL dialog box is
displayed to allow an IP address of an image or document file to be
entered.

When IBM Daeja ViewONE is used on a website there is normally no need
to select a file because a document is loaded automatically when the web
page is visited.

@ Close

Closes the currently open document and releases resources held by that
document.

E? Save

Displays a save file dialog box from which you can select an image or
document file to save the currently loaded document. This button is
available only when the current document is a single file (single image file
or multipage TIFF file). Documents that are loaded by using separate files
for each page cannot be saved to the local disk.
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Print button

The “Print” button is:

Print

Te2@E o aq Ba Qo =

I:E—-LI Print

The “Print” button displays a print dialog box from which you can select a
printer to print the current document. When this button is clicked while
holding the shift-key the print operation prints the only the current page of a
multipage document. (Additional print options are available by using
menus).
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Image buttons

The image buttons are:
Zoom area, Zoom in, Zoom out, Magnify, Fit to width, Fit to height, Best fit, Rotate

clockwise, Rotate counterclockwise, Rotate 180, Flip horizontally, Flip vertically,
and Invert.

EEEEE] PR 0

i Zoom Area

The “Zoom area” button changes the mouse pointer to a cross and allows a
rectangle to be selected for zooming. When the mouse is released, the
selected area is zoomed to fill the display area.

To return the mouse pointer to the “panning mode” click this button again.

@y Zoomin

)
The “Zoom in” button zooms the current page by an additional 25% each
time it is clicked. When the page is zoomed so that it no longer fits into the
display area, scrollbars automatically appear. When the magnifier window
is visible, zooming in increases the magnifier size.

Right-clicking this button zooms the thumbnails in the thumbnail view.

Zoom out

The “Zoom out” button decreases the zoom 25% each time it is clicked.
When the magnifier window is visible, zooming out decreases the magnifier
size.

Right-clicking this button decreases the zoom of the thumbnails in the
thumbnail view.

|L_'l | Magpnify

The ‘Magnify’ button displays a magnifier window to allow selected areas of
the current page to be magnified. If you right-click this button, the magnifier
is displayed in a separate window.

To close the magnifier, click this button again.

13
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Zoom 100%

The “Zoom 100%" button displays the page at full resolution. When the
page is zoomed so that it no longer fits into the display area then scrollbars
will automatically appeatr.

Fit to Height

The “Fit to Height” button scales the current page so that the page height
matches the display area height. If this button causes the page width to be
larger than the display area width, a horizontal scrollbar automatically
appears.

Fit To Width

The “Fit to Width” button scales the current page so that the page width
matches the display area width. If this button causes the page height to be
larger than the display area width, a vertical scrollbar automatically
appears.

Best Fit

The “Best fit” button scales the current page so that the whole page is
visible in the display area. This mode is selected by default when the applet
is started.

Rotate Clockwise

The “Rotate clockwise” button rotates the current page and thumbnail by 90
degrees each time it is clicked. You can right-click this button to apply the
rotate operation to all pages in the document rather than just the current

page.
Rotate Counterclockwise

The “Rotate counterclockwise” button rotates the current page and
thumbnail by 90 degrees counterclockwise each time it is clicked. You can
right-click this button to apply the rotate operation to all pages in the
document rather than just the current page.

Rotate 180

The “Rotate 180" button rotates the current page and thumbnail by 180
degrees each time it is pressed.

Flip Horizontal

The “Flip horizontal” button flips the current page and thumbnail
horizontally. Clicking this button again restores the page.
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Flip Vertical

The “Flip vertical” button flips the current page and thumbnail vertically.
Clicking this button again restores the page.

Invert

The “Invert” button inverts the colors used to display the current page and
thumbnail. Clicking this button again restores the page.

15



Help button

The “Help” button is:

Help

222 & Qa6 B§ ENCIIE]

@ Help

The “Help” button typically causes a separate browser window to open
containing the user help manual. However, the specific way in which this
button works is configurable and so might differ between implementations.

16



New window button

The “New window” button is:

New Window

5- New Window

The “New window” button creates a new window that also contains the
current document. This window is useful when IBM Daeja ViewONE is
used on a website that does not permit the display area to be resized or is
perhaps too small. The new window includes all the normal buttons and
menus.

17



Status Bar

Page buttons

The page buttons appear only for multipage documents and are:

First page, Previous page, Next page, Last page, and a drag bar for page
selection.

[ ] 4]z »/w @ | B | M [Pagetof3.. viewonepro |

M|  First Page
The “First page” button displays the first page of the document.
[4]  Previous Page

The “Previous page” button displays the previous page of the document.
This button functions only when the current page is two or greater.

[»]  NextPage

The “Next page” button displays the next page of the document. This button
functions only when the current page is not the last page.

(M| LastPage

The “Last page” button changes the page to the last page of the document.

Drag Bar

The drag bar allows an individual page to be selected. As the bar is
dragged, the caption in the status bar indicates which page will be selected
when the bar is released.

It is also possible to use the left and right arrow keys to adjust the position
of the scrollbar after the bar is clicked.
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Enhance button

The “Enhance” button is:

Enhance.

\

I0E

3 r W @ | | |Page 10f 3. viewoncpro |

Enhance Mode

Changes the anti-aliasing mode that is being used to display images. Anti-
aliasing is an algorithm that enhances the readability of an image that would
otherwise be degraded as it is reduced to fit the display area.

IBM Daeja ViewONE has seven different anti-aliasing modes as follows:

Enhance off

Enhance level (auto)

Enhance level (auto — sharp)

Enhance level (auto — sharper)

Enhance level (typical images)

Enhance level (drawings)

Enhance level (very high-resolution drawings)

It is recommended that you leave this set to the default setting because the
viewer usually interprets the images and defaults to the best anti-aliasing
algorithm to use.

If however, you need greater clarity for a particular image being viewed
then you can adjust this setting to achieve this.

Note that IBM Daeja ViewONE remembers the last setting as a preference
and will use the same setting for subsequent images unless over-ridden by
a default HTML parameter or adjusted using the button again.

19



Image Properties button

The “Image Properties” button is:

Image properties

I0E v w[ @] | M |[Pagetof3.. viewonepro |

ﬂ Image Properties

Displays a list of image properties for the image that is currently being
viewed.

The information that is displayed includes:

File name, length and format

Width, height and resolution information

Network download, decompression, and rendering times
Page information

Other information extracted from the image file

20



Image Resolution button

The image resolution button is available only for specific format images (PDF and
Microsoft Word) and is:

Image Resolution

TI0E v/ v @ [FE| M |[Page1of3.. viewonepro |

Clicking this button brings up a set of resolution values (in dots per inch). Note that
you must clear the “Optimize for performance” option for your specified resolution
value to take effect

21



View buttons

The view buttons are:

Full page, Thumbnails, Two-page, Thumbs-left, Thumbs-bottom, Thumbs-right,
Thumbs-top.

|
IoEmEmD RME B

D Full Page

When the “Full page” button is selected, a single view of the current page is
displayed.

EEIEI Thumbnails

When the “Thumbnails” button is selected, a view of the thumbnails is
displayed with as many thumbnails as will fit in the available area.

Right-clicking this button results in only the pages that were selected by
using the selection menu or S key being displayed.

‘hl'hl Two Page

When the “Two-page” button is selected, two pages are displayed.

Right-clicking this button results in only the pages that were selected by
using the selection menu or S key being displayed.

EID Thumbs Left

When the “Thumbs-left” button is selected, thumbnails are displayed to the
left of the page.

Right-clicking this button results in only the pages that were selected by
using the selection menu or S key being displayed.
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|:b| Thumbs Bottom

(|
When the “Thumbs-bottom” button is selected, thumbnails are displayed at

the bottom of the page.

Right-clicking this button results in only the pages that were selected by
using the selection menu or S key being displayed.

DEI Thumbs Right

When the “Thumbs-right” button is selected, thumbnails are displayed to
the right of the page.

Right-clicking this button results in only the pages that were selected by
using the selection menu or S key being displayed.

OO Thumbs Top

When the “Thumbs-top” button is selected, thumbnails are displayed at the
top of the page.

Right-clicking this button results in only the pages that were selected by
using the selection menu or S key being displayed.
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Adjust bars

All, some, or none of these bars might be visible depending on the applet's
configuration parameters. The adjust bars are accessible from the adjustment
button in the lower toolbar:

)

Adjust Luminance, Adjust Contrast, Adjust Brightness.

Adjust Luminance

: When the “Luminance” scrollbar is moved, the luminance
: properties of the display are altered. When the icon at the
end of the bar is clicked, the scrollbar goes to its center.

:\ | The scrollbar can be moved with the mouse or the up and
down arrow keys on the keyboard.
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Adjust Contrast

When the “Contrast” scrollbar is moved, the contrast
properties of the display are altered. When the icon at the
end of the bar is clicked, the scrollbar goes to its center.

The scrollbar can be moved with the mouse or the up and
down arrow keys on the keyboard.

Adjust Brightness

When the “Brightness” scrollbar is moved, the brightness
properties of the display are altered. When the icon at the
end of the bar is clicked, the scrollbar goes to its center.

The scrollbar can be moved with the mouse or the up and
down arrow keys on the keyboard.

25



Menus

When IBM Daeja ViewONE is used within a browser, the context menus are
accessed by clicking mouse button two or three. This is usually the right button, or
on Macintosh machines, the same is achieved by holding down the single button
for more than a second.

This section should be used in conjunction with the Toolbars section, which
provides more detailed explanations of the same options that are available by
using buttons.

File menu

The file menu provides options to open a document (file or Internet URL), close the
document or save the document or selected pages to local disk. Using the “New
window” option, a new window (frame) can be created that contains the currently
open document.

open e ©

Open URL (Shift-O
View S ( )

Close (C
Image » ©

Mew window
Adjust » o)

Save document (F)

Print r
Save page
Page Y| Save selected pages
Selection »
Clipboard ’

Preferences r
Cache k

Help r
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View menu

The view menu provides options to change the page view. The current page can
be viewed on its own, thumbnails can be viewed on their own, or a combination of
both can be achieved.

File r

wew e 2

View thumbnails (F3)
View two pages (F4)

Image k

Adjust »

v Yiew thumbnails: Left (F5)
Print ¥ Viewthumbnails: Bottom (F6)
p | View thumbnails: Right (F7)

Page

View thumbnails: Top (F8)
Selection »

Switch to index (F12)
Clipboard »

Preferences »

Cache k

Help r
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Image menu

The image menu provides options to change the zoom factor, magnify, rotate, flip,
enhance mode, and invert of the displayed image.

File b

View L

m Fit to window width (F9)

Fit to window height (F10)

Adjust 3
Fit to window (F11)
Print 3
Zoomin (+)
il 2 *| Zoom out(-)
Selection p | Loomto 100% (2)
Zoom area (A)
Clipboard 3

IMagnifier (M)

Preferences L4

Raotate clockwise (R)

Cache *| Rotate counterclockwise (L)

Help »| Rotate 180 degrees

Mirrar
Flip

Change enhance maode (E)

Invert (1}

Display as grayscale

Enhance g

Image Properties (Shift-1)

Notes:

For the rotation options, you can right-click these options to apply the rotate
operation to all pages in the document rather than just the current page.

For the magnification options, if the magnifier window is visible then zooming in
and zooming out increases and decreases the magnifier size.
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The “display as grayscale” option is only available for 24-bit color images.

Adjust menu

The adjust menu provides options to change the luminance, contrast, and
brightness properties of the display. All, some, or none of these menu options
might be visible depending on the applet’s configuration parameters.

File r
View s
Image »
Adjust = Luminance +
— , Luminance -
Reset luminance
Page s
Contrast +
Selection ¥ Contrast-
Clipboard | Resetcontrast
Preferences b ELLIEEE
Brightness -
Cache g Reset brightness
Help +
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Print menu

The print menu provides options to print the current page, all pages (document), a
page range, or pages selected (selected by using the select menu).

File ’

View r

Image »

Adjust r

m Print page (P)

Page ¥ Print page range (Ctrl-P)
Selection k| Print selected pages (Shift-Ctrl-F)
Clipboard ¥ Print document (Shift-P)
Preferences ¥ Printvisible

Cache , Print Transformed
Help »

Print Visible

This option print the portion of the image that is currently displayed in the viewer’s
main display area. All rotations, inverts, flips, and so on, are included in the print.

Print Transformed
This option prints the current page with all the rotations, inverts, flips, and so on

included. The feature is available only to Microsoft Windows, IBM Daeja ViewONE
print accelerator users.
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Page menu

The page menu provides options to view the next, previous, first, or last page.

File k
View L
Image L
Adjust k
Print *

TR votvaoe AGE Down)

Previous page (FAGE LIF)

Selection L4

First page (HOME)

Clipboard 4
Last page (EMD)

Preferences »

Goto page ()

Cache k

Help L
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Select menu

The select menu provides “select page” for selecting the current page and “clear
selections” for clearing all currently selected pages.

File »
View »
Image 4
Adjust r
Print »
Page 4
v Select page (S)
Clipboard " Clear selections (Ctrl-3)

Preferences L

Cache r

Help k
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Preference menu

The preference menu provides options to adjust thumbnail display size and to
change the color used for the background on monochrome images. When you
select the “change background color” or “change foreground color” options, a
dialog box appears to allow you to choose the color you want.

If you have the Print Accelerator module, there are additional options for selecting
printing preferences.

IBM Daeja ViewONE remembers your preferences and uses them the next time
you use the viewer unless they are overridden by an HTML parameter in the
source code.

File S
View »
Image k
Adjust L4
Print g
Page L4
| Selection L5
Clipboard L4

Thumbnails - larger
Thumbnails - smaller

Cache k|

Thumbnails - reset
Help L&l

Change background color
Change foreground color

v Display color progressively
Display monochrome progressively

Change number of colors (FDF documents) g
Change image resolution (FDF documents) L
Change image resolution (Office documents) L§

Print document without color (quickest)
v Print document with color (slowest)

Print original size

v Print sticky notes
v Print sticky note text

33



Clipboard menu

The clipboard menu provides options to copy the current image into the Windows
clipboard.

File »
View r
Image k
Adjust r
Print r
Page »
Selection r

Clipboard & Copy page to clipboard (Ctrl-C)

Copy selected area to clipboard

Preferences »

v Empty clipboard on close
Cache L P clip

Help »
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Help menu

The help menu provides options to view the user help manual (if configured to do
so0) and the “about IBM Daeja ViewONE" dialog box.

File »
View »
Image L
Adjust »
Print k
Page »
Selection r
Clipboard r
Preferences k
Cache »
elo €

About ViewOMNE Pro
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The Keyboard

IBM Daeja ViewONE provides keyboard access to the same functions offered by
the toolbars.

This section is designed to be used in conjunction with the Toolbars section, which
provides more detailed explanations of the same options.

File keys

Open file @)
Open URL Shift+O
Close C
Save F
New window W
View keys

View page F2
View thumbnails F3
View two page F4
View thumbnails: Left F5
View thumbnails: Bottom F6
View thumbnails: Right F7
View thumbnails: Top F8

36



Image keys

Fit to window width F9

Fit to window height F10

Fit to window F11

Zoom in +...0r... Shift+=
Zoom out —...or... Shift+—
Magnifier M

Increase magnifier size +...or... Shift+=
Decrease magnifier size —...or... Shift+—
Increase magnifier width Shift+Right Arrow
Decrease magnifier width Shift+Left Arrow
Increase magnifier height Shift+Up Arrow
Decrease magnifier height Shift+Down Arrow
Increase magnifier factor *...or... Shift+0

Decrease magnifier factor /...or... Shift+9
Zoom to 100% Z
Zoom area A
Rotate clockwise R
Rotate counterclockwise L
Enhance E

|

Invert

Note: When the magnifier window is visible then zooming in and zooming out will
increase and decrease the magnifier size. However, if, while the magnifier window
is visible, you hold down Shift while using the + or — keys then the viewer will zoom
in or zoom out of the document instead.

Print keys

Print page P

Print document Shift+P
Print page range Ctrl+P

Print selected pages Ctrl+Shift+P
Page keys

Next page Page Down
Previous page Page Up
First page Home

Last page End
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Select keys

Select page
Clear all pages

Clipboard keys

Copy page to clipboard

Scrolling keys

Scroll right
Scroll left
Scroll up
Scroll down

Toolbar keys

Ctrl+S

Ctrl+C

Right Arrow
Left Arrow
Up Arrow
Down Arrow

These keys can be used on any of the toolbars found in IBM Daeja ViewONE:

Go to start of toolbar
Go to end of toolbar
Go to center of toolbar

HOME
END
INSERT

When the focus is on a vertical scrollbar the up and down arrow keys move the
scrollbar up and down. When it is on a horizontal scrollbar the left and right arrow
keys move the scrollbar left and right.
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Notices
Thisinformation was developed for products and services offered in the U.S.A.

IBM® may not offer the products, services, or features discussed in this document
in other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any referenceto an IBM
product, program, or serviceis not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectua property right may
be used instead. However, it isthe user's responsibility to evauate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you any
license to these patents. Y ou can send license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive Armonk, NY 10504-1785
USA.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing

Legal and Intellectua Property Law

IBM Japan Ltd.

19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

Thefollowing paragraph does not apply to the United Kingdom or any other
country where such provisonsareinconsstent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES
THISPUBLICATION “ASIS’ WITHOUT WARRANTY OF ANY KIND,
EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO,
THE IMPLIED WARRANTIES OF NON-INFRINGEMENT,
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some
states do not alow disclaimer of express or implied warrantiesin certain
transactions, therefore, this statement may not apply to you.

Thisinformation could include technical inaccuracies or typographica errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this publication
at any time without notice.
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Any referencesin thisinformation to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
dtes. The materias at those Web sites are not part of the materiasfor thisIBM
product and use of those Web sitesis at your own risk.

IBM may use or distribute any of the information you supply in any way it believes
appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of
enabling: (i) the exchange of information between independently created programs
and other programs (including this one) and (ii) the mutual use of the information
which has been exchanged, should contact:

IBM Corporation
JA6A/GA

555 Bailey Avenue

San Jose, CA 95141-1003
U.SA.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of afee.

The licensed program described in this document and all licensed materia available
for it are provided by IBM under terms of the IBM Customer Agreement, IBM
International Program License Agreement or any equival ent agreement between us.

Thisinformation contains examples of dataand reports used in daily business
operations. To illustrate them as completely as possible, the examplesinclude the
names of individuas, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actua business
enterpriseisentirely coincidental.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generdly available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actua results may vary. Users of this document
should verify the gpplicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other clams related to non-IBM products.
Questions on the capabilities of non-1IBM products should be addressed to the
suppliers of those products.
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All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goa's and objectives only.

Thisinformation contains examples of dataand reports used in daily business
operations. To illustrate them as completely as possible, the examplesinclude the
names of individuas, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actua business
enterpriseisentirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. Y ou may copy,
modify, and distribute these sample programsin any form without payment to

IBM, for the purposes of devel oping, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not been
thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply
reliability, serviceahility, or function of these programs.

Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
Internationa Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarksis available on the web at "' Copyright and
trademark information” at http://www.ibm.com/legal/us/en/copytrade.shtml.

Adobe, the Adobe logo, PostScript, and the PostScript logo are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States,
and/or other countries.

Microsoft, Windows, and Windows NT are trademarks of Microsoft Corporation in
the United States, other countries, or both.

Javaand al Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.

Other company, product, and service names may be trademarks or service marks of
others.

Privacy policy considerations

IBM Software products, including software as a service solutions, (* Software
Offerings’) may use cookies or other technologies to collect product usage
information, to help improve the end user experience, to tailor interactions with the
end user or for other purposes. In many cases no personally identifiable information
is collected by the Software Offerings. Some of our Software Offerings can help
enable you to collect persondly identifiable information. If this Software Offering
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uses cookies to collect personally identifiable information, specific information
about this offering’s use of cookiesis set forth below.

Depending upon the configurations deployed, this Software Offering may use
cookies that collect each user’ s user name for purposes of session management,
authentication, and enhanced user usability. These cookies cannot be disabled.

If the configurations deployed for this Software Offering provide you as customer
the ability to collect persondly identifiable information from end users via cookies
and other technologies, you should seek your own legal advice about any laws
applicable to such data collection, including any requirements for notice and
consent.

For more information about the use of various technologies, including cookies, for
these purposes, See IBM’s Privacy Policy at http://www.ibm.com/privacy and
IBM’s Online Privacy Statement at http://www.ibm.com/privacy/details the section
entitled “Cookies, Web Beacons and Other Technologies’ and the“1BM Software
Products and Software-as-a-Service Privacy Statement” at
http://www.ibm.com/software/info/product-privacy.
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